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The leading book on Microsoft Office, now fully updated for Office 2010Microsoft Office, the
world's leading productivity suite, has been updated with new tools. Veteran Office users as well
as newcomers will need the comprehensive information in this bestselling All-in-One guide.With
a self-contained minibook devoted to each Office application plus minibooks on how Office
works together and how you can expand its usefulness, Office 2010 All-in-One For Dummies
gets you up to speed and answers the questions you'll have down the road.Microsoft Office is
the office productivity suite used around the globe; nearly every business worker encounters it
dailyThe 2010 revision will affect all applications in the suiteEight minibooks cover Word, Excel,
PowerPoint, Outlook, Access, Publisher, common Office tools, and ways to expand Office
productivityAlso covers the new online versions of Word, Excel, and PowerPoint as well as
changes to the interface and new tools and techniquesOffice 2010 All-in-One For Dummies
makes it easy to learn to use Office and gets you up and running on all the changes and
enhancements in Office 2010.

More to Explore: See More Office 2010 Resources Title Guide Type Tutorial Tutorial and
Video Training Training Guide and Interactive Course Web-Based Training Software Audience
Level Beginner Beginner to Intermediate Beginner to Intermediate Beginner to Intermediate
Pages 432 816 416 N/A List Price $27.99 $34.99 $39.99 $59.99 Author(s) Wallace Wang
Peter Weverka Faithe Wempen Faithe Wempen Publication Date July 2010 May 2010
November 2011 October 2012 Imprint For Dummies For Dummies For Dummies For Dummies
From the Inside Flap8 BOOKS IN 1Common Office
ToolsWordOutlook®PowerPoint®Excel®Access®PublisherOffice 2010 — One Step
BeyondWelcome to Office 2010! Here's where you get up to speed on all the applications —
right now!If you want to get your work done better and faster with Office 2010, this book is for
you. Whether you're new to Office or need help navigating Office 2010's interface and new
features, you'll find the answers, how-to information, advice, shortcuts, and tips right here. And
you'll learn how the tools work together to make you more productive!They're a team — explore
commands and features common to all the Office programs plus techniques to boost your
productivityWorking with Word — create letters, reports, newsletters, mass mailings, and
moreImprove your Outlook — manage your e-mail, track tasks, keep an address book and
calendar, and organize your lifeGet your Point across — build livelier, more original PowerPoint
presentations and even improve your deliveryExcel at number crunching — design
spreadsheets that are easy to understand, use data-validation rules, and analyze dataAccess
your information — discover all the ways you can build and use an Access databaseYour own
Publisher — turn out great brochures, pamphlets, and other publicationsA step beyond — check



out the extra programs and customize your OfficeOpen the book and find:The common tools
you'll find in all Office applicationsClear instructions for revising and collaborating on
documentsTips on building tables, charts, and diagrams in Excel, Word, and PowerPointWord's
tools for creating scholarly reports and white papersAdvice on scheduling events with
OutlookSecrets of memorable PowerPoint presentationsHow to build an Access database from
scratchHints for creating newsletters in PublisherFrom the Back Cover8 BOOKS IN 1Common
Office ToolsWordOutlook®PowerPoint®Excel®Access®PublisherOffice 2010  One Step
BeyondWelcome to Office 2010! Here's where you get up to speed on all the applications  right
now!If you want to get your work done better and faster with Office 2010, this book is for you.
Whether you're new to Office or need help navigating Office 2010's interface and new features,
you'll find the answers, how-to information, advice, shortcuts, and tips right here. And you'll learn
how the tools work together to make you more productive!They're a team  explore commands
and features common to all the Office programs plus techniques to boost your
productivityWorking with Word  create letters, reports, newsletters, mass mailings, and
moreImprove your Outlook  manage your e-mail, track tasks, keep an address book and
calendar, and organize your lifeGet your Point across  build livelier, more original PowerPoint
presentations and even improve your deliveryExcel at number crunching  design spreadsheets
that are easy to understand, use data-validation rules, and analyze dataAccess your information
 discover all the ways you can build and use an Access databaseYour own Publisher  turn out
great brochures, pamphlets, and other publicationsA step beyond  check out the extra
programs and customize your OfficeOpen the book and find:The common tools you'll find in all
Office applicationsClear instructions for revising and collaborating on documentsTips on
building tables, charts, and diagrams in Excel, Word, and PowerPointWord's tools for creating
scholarly reports and white papersAdvice on scheduling events with OutlookSecrets of
memorable PowerPoint presentationsHow to build an Access database from scratchHints for
creating newsletters in PublisherAbout the AuthorPeter Weverka is a veteran For Dummies
author who has covered a wide variety of Microsoft applications. In addition to PowerPoint 2007
All-in-One For Dummies and two previous editions of Office All-in-One For Dummies, he is the
author of several editions of Microsoft Money For Dummies.Excerpt. © Reprinted by permission.
All rights reserved.Office 2010 All-in-One For DummiesBy Peter WeverkaJohn Wiley &
SonsCopyright © 2010 John Wiley & Sons, LtdAll right reserved.Chapter OneCustomizing an
Office ProgramIn This Chapter Personalizing the Ribbon Changing around the Quick Access
toolbar Choosing what appears on the status bar Choosing a new color scheme Devising
keyboard shortcuts in WordThis chapter describes a handful of things you can do to customize
Office 2010 programs. Don't be afraid to make like a software developer and change a program
to your liking. Many people are wary of retooling Office programs, but you can always reverse the
changes you make if you don't like them, as I explain throughout this chapter.This chapter shows
how to put your favorite button commands on the Ribbon and Quick Access toolbar. Instead of
fishing around for your favorite commands, you can assemble them on the Ribbon or Quick



Access toolbar and locate them right away. You also discover how to change around the status
bar, dress up an Office program in a new set of clothes, and designate your own keyboard
shortcuts in Word.Customizing the RibbonAs you surely know by now, the Ribbon is the stretch
of ground across the top of all Office programs. The Ribbon is composed of tabs. On each tab,
commands are arranged by group. To undertake a task, you visit a tab on the Ribbon, find the
group with the command you want, and choose the command. If you are so inclined, you can
customize the Ribbon. You can place the tabs and commands you know and love where you
want to find them on the Ribbon. And you can remove tabs and commands that aren't useful to
you.To customize the Ribbon, open the Customize Ribbon tab of the Options dialog box with
one of these techniques:File* On the File tab, choose Options, and select the Customize Ribbon
category in the Options dialog box.* Right-click a tab or button and choose Customize the
Ribbon.You see commands for customizing the Ribbon, as shown in Figure 1-1. The right side of
the dialog box ("Customize the Ribbon") lists the names of tabs, groups within tabs, and
commands within groups that are currently on the Ribbon. To customize the Ribbon, you arrange
the right side of the dialog box to your liking. You list the tabs, groups, and commands that you
want for the Ribbon on the right side of the dialog box.The left side of the dialog box ("Choose
Commands From") presents every tab, group, and command in your Office program. To
customize the Ribbon, you select a tab, group, or command on the left side of the dialog box and
move it to the right side.Keep reading to find out how to display tabs, groups, and commands in
the Options dialog box and how to do all else that pertains to customizing the Ribbon. In case
you make a hash of the Ribbon, you also find instructions for restoring the Ribbon to its original
state.Displaying and selecting tab, group, and command namesTo customize the Ribbon, you
need to display and select tab names, group names, and command names in the Options dialog
box (refer to Figure 1-1). Start by opening the drop-down lists and choosing a display option:*
Choose Commands From: Choose an option to locate the tab, group, or command you want to
add to the Ribbon. For example, choose All Commands to see an alphabetical list of all the
commands in the Office program you're working in; choose Main Tabs to see a list of tabs.*
Customize the Ribbon: Choose an option to display the names of all tabs, main tabs, or tool
tabs. Tool tabs are the context-sensitive tabs that appear after you insert or click something. For
example, the Table Tools tabs appear when you construct tables.After you choose display
options on the drop-down lists, display the names of groups and commands (refer to Figure
1-1):* Displaying group names: Click a plus sign icon next to a tab name to see the names of its
groups. You can click the minus sign icon to fold group names back into a tab name.* Displaying
command names in groups: Click the plus sign icon next to a group name to see the names of
its commands. You can click the minus sign icon to collapse command names.After you display
the tab, group, or command name, click to select it.Moving tabs and groups on the RibbonTo
change the order of tabs on the Ribbon or groups on a tab, go to the Customize Ribbon
category of the Options dialog box (refer to Figure 1-1) and select the name of a tab or group on
the right side of the dialog box. Then click the Move Up or Move Down button. Click these



buttons as necessary until tabs or groups are in the order that you see fit.WARNING!Be careful
about moving groups by clicking the Move Up or Move Down button. Clicking these buttons too
many times can move a group to a different tab on the Ribbon.Adding, removing, and renaming
tabs, groups, and commandsIn the Options dialog box (refer to Figure 1-1), display and select
the tab, group, or command you want to add, remove, or rename. Then proceed to add, remove,
or rename it. (Earlier in this chapter, "Displaying and selecting tab, group, and command names"
explains how to display items in the Options dialog box.)Adding items to the RibbonFollow these
steps to add a tab, group, or command to the Ribbon:1. On the left side of the Customize Ribbon
tab of the Options dialog box, select the tab, group, or command you want to add. For example,
to add the Tables group to the Home tab, select the Tables group.2. On the right side of the
dialog box, select the tab or group where you want to place the item.If you're adding a tab to the
Ribbon, select a tab. The tab you add will go after the tab you select.3. Click the Add
button.Removing items from the RibbonFollow these steps to remove a tab, group, or command
from the Ribbon:1. On the right side of the Customize Ribbon tab of the Options dialog box,
select the tab, group, or command you want to remove.2. Click the Remove button.Except for
tabs you create yourself, you can't remove tabs from the Ribbon. And you can't remove a
command unless you remove it from a group you created yourself.Renaming tabs and
groupsSorry, you can't rename a command. As for tabs and groups, you can rename them, but
only if you created them yourself. Tabs and groups that came with Office can't be renamed.
Follow these steps to rename a tab or group:1. On the right side of the Customize Ribbon tab of
the Options dialog box, select the tab or group you want to rename.2. Click the Rename
button.You see the Rename dialog box.3. Enter a new name and click OK.Creating new tabs
and groupsCreate new tabs and groups on the Ribbon for commands that are especially useful
to you. Follow these steps on the Customize Ribbon tab of the Options dialog box (refer to
Figure 1-1) to create a new tab or group:1. On the right side of the dialog box, display and select
the name of a tab or group.Earlier in this chapter, "Displaying and selecting tab, group, and
command names" explains how to select items in the Options dialog box.Tab: If you're creating a
tab, select a tab name. The tab you create will appear after the tab you select.Group: If you're
creating a group, select a group name. The group you create will appear after the group you
select.2. Click the New Tab or New Group button.Your Office program creates a new tab or
group called "New Tab (Custom)" or "New Group (Custom)." If you created a tab, Office also
creates a new group inside your new tab.3. Click the Rename button to give the tab, group, or
both a name.In the Rename dialog box, enter a descriptive name and click OK. If you're naming
a group, the Rename dialog box gives you the opportunity to select an icon to help identify the
group.4. Add groups, commands, or both to your newly made tab or group.For instructions, see
"Adding items to the Ribbon," earlier in this chapter.Resetting your Ribbon customizationsIf you
make a hash of the Ribbon, all is not lost because you can restore the original settings. In the
Options dialog box, click the Reset button (refer to Figure 1-1) and choose one of these
commands on the drop-down list:* Reset Only Selected Ribbon Tab: Select a tab name on the



right side of the Options dialog box and choose this command to restore a tab to its original
state.* Reset All Customizations: Choose this command to restore the Ribbon in its entirety. All
changes you made are reversed.You can also remove tabs and groups you created if you
discover you don't need them. See "Removing items from the Ribbon," earlier in this
chapter.Customizing the Quick Access ToolbarNo matter where you go in Office, you see the
Quick Access toolbar in the upper-left corner of the screen. This toolbar offers the Save, Undo,
and Repeat buttons. However, which buttons appear on the Quick Access toolbar is entirely up
to you. You can put your favorite buttons on the toolbar to keep them within reach. And if the
Quick Access toolbar gets too big, you can move it below the Ribbon, as shown in Figure 1-2.
Adding buttons to and removing buttons from the Quick Access toolbar is, I'm happy to report, a
piece of cake. And moving the toolbar below the Ribbon is as easy as pie.Adding buttons to the
Quick Access toolbarUse one of these techniques to add buttons to the Quick Access toolbar:*
Right-click a button you want to see on the toolbar and choose Add to Quick Access Toolbar on
the shortcut menu (refer to Figure 1-2). You can add all the commands in a group to the Quick
Access toolbar by right-clicking the group name and choosing Add to Quick Access Toolbar.*
Click the Customize Quick Access Toolbar button (this button is located to the right of the Quick
Access toolbar) and choose a button on the drop-down list. The list offers buttons deemed most
likely to be placed on the Quick Access toolbar by the makers of Office.* On the File tab, choose
Options, and select the Quick Access Toolbar category in the Options dialog box (or right-click
any button or tab and choose Customize Quick Access Toolbar on the shortcut menu). You see
the Quick Access Toolbar category of the Options dialog box, as shown in Figure 1-3. On the
Choose Commands From drop-down list, select the name of the tab with the button you want to
add to the Quick Access toolbar. Then select the button's name and click the Add button.To
restore the Quick Access toolbar to its original buttons, click the Reset button in the Options
dialog box (refer to Figure 1-3) and choose Reset Only Quick Access Toolbar on the drop-down
list. Choosing Reset All Customizations resets Ribbon customizations as well as Quick Access
toolbar customizations.Changing the order of buttons on the Quick Access toolbarFollow these
steps to change the order of buttons on the Quick Access toolbar:1. Click the Customize Quick
Access Toolbar button and choose More Commands on the drop-down list.The Quick Access
Toolbar category of the Options dialog box appears (refer to Figure 1-3). You can also open this
dialog box by right-clicking any button or tab and choosing Customize Quick Access Toolbar.2.
Select the name of a button on the right side of the dialog box and click the Move Up or Move
Down button.3. Repeat Step 2 until the buttons are in the right order.4. Click OK.Removing
buttons from the Quick Access toolbarUse one of these techniques to remove buttons from the
Quick Access toolbar:* Right-click a button and choose Remove from Quick Access Toolbar on
the shortcut menu.* Right-click any button or tab and choose Customize Quick Access Toolbar.
You see the Quick Access Toolbar category of the Options dialog box (refer to Figure 1-3).
Select the button you want to remove on the right side of the dialog box and click the Remove
button.REMEMBERYou can click the Reset button in the Options dialog box (refer to Figure 1-3)



to remove all the buttons you placed on the Quick Access toolbar.Placing the Quick Access
toolbar above or below the RibbonThe Ribbon is the stretch of ground along the top of the
screen where the tabs and buttons are found. If your Quick Access toolbar contains many
buttons, consider placing it below the Ribbon, not above it (refer to Figure 1-3). Follow these
instructions to place the Quick Access toolbar above or below the Ribbon:* Quick Access
toolbar below the Ribbon: Right-click the toolbar, and on the shortcut menu, choose Show Quick
Access Toolbar Below the Ribbon.* Quick Access toolbar above the Ribbon: Right-click the
toolbar, and on the shortcut menu, choose Show Quick Access Toolbar Above the Ribbon.The
Options dialog box offers a check box called Show Quick Access Toolbar Below the Ribbon
(refer to Figure 1-3). You can select this check box as well to move the toolbar below the
Ribbon.Customizing the Status BarThe status bar along the bottom of the window gives you
information about the file you're working on. The Word status bar, for example, tells you which
page you're on, how many pages are in your document, and several other things. In PowerPoint,
the status bar tells you which slide you're looking at and the theme you chose for your
presentation. The status bar also presents the view buttons and Zoom controls.To choose what
appears on the status bar, right-click the status bar. You see a drop-down list similar to the one in
Figure 1-4. By selecting and deselecting items in this list, you can decide what appears on the
status bar.Changing the Color SchemeFigure 1-5 shows three color schemes with which you
can dress up Excel, Outlook, Access, Word, Publisher, and PowerPoint: Blue, Silver, and Black.
Which do you prefer? Follow these steps to choose a color scheme:File1. On the File tab,
choose Options.You see the Options dialog box.2. Select the General category.3. Open the
Color Scheme drop-down list and choose Blue, Silver, or Black.4. Click OK.How do you like your
new get-up?Customizing Keyboard Shortcuts in WordIn Microsoft Word, you can change the
keyboard shortcuts. A keyboard shortcut is a combination of keys that you press to give a
command. For example, pressing Ctrl+P opens the Print window; pressing Ctrl+S gives the Save
command. If you don't like a keyboard shortcut in Word, you can change it and invent a keyboard
shortcut of your own. You can also assign keyboard shortcuts to symbols, macros, fonts,
AutoText entries, and styles.Follow these steps to choose keyboard shortcuts of your own in
Microsoft Word:File1. On the File tab, choose Options.You see the Word Options dialog box.2.
Select the Customize Ribbon category.3. Click the Customize button (you can find it at the
bottom of the dialog box next to the words "Keyboard Shortcuts").You see the Customize
Keyboard dialog box, as shown in Figure 1-6.4. In the Categories list, choose the category with
the command to which you want to assign the keyboard shortcut.At the bottom of the list are the
Macros, Fonts, AutoText, Styles, and Common Symbols categories.5. Choose the command
name, macro, font, AutoText entry, style, or symbol name in the Commands list.6. In the Press
New Shortcut Key box, type the keyboard shortcut.Press the actual keys. For example, if the
shortcut is Ctrl+8, press the Ctrl key and the 8 key - don't type out C-t-r-l-+8.If you try to assign a
shortcut that has already been assigned, the words "Currently assigned to" and a command
name appear below the Current Keys box. You can override the preassigned keyboard



assignment by entering a keyboard assignment of your own.(Continues...)Excerpted from Office
2010 All-in-One For Dummiesby Peter Weverka Copyright © 2010 by John Wiley & Sons, Ltd.
Excerpted by permission.All rights reserved. No part of this excerpt may be reproduced or
reprinted without permission in writing from the publisher.Excerpts are provided by Dial-A-Book
Inc. solely for the personal use of visitors to this web site.Read more
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Richard E. J. Burke, “This is a go-to reference book.. Nobody starts into MS Office by reading a
manual. Office's apparent ease-of-use can lead a newbie into bad habits by "satisficing" with
inefficient methods "just so long as I get the job done." An old pro with experience back to the
DOS versions can easily cruise along without ever realizing the existence of--much less how to
use--the enormous productivity improvements in the more recent programs. I have grown aware
over the years of things I could do with the programs, and I have this manual handy for those
special moments when I'm sick of wasting time with workarounds and realize I can do it better
with an unused feature. However, I have I do not yet know how I can discover what is possible in
these programs in a systematic way, rather than through the serendipity of chance conversations
or reading reviews. If someone could write such a book, and it would take great writing skill
PLUS knowledge of the applications, then his financial future would be secure. For now, this is
my reference.”

Rolene Schriedel, “Office 2010 for Dummies is perfect. My husband and I have used MS Office
2003 since it came out (yes, we were still in the stone age of computers). Many companies now
use Office 2007, 2010, and even 2013. We upgraded our Windows Vista to Windows 8 and also
upgraded to Office 2013. Wow! What a big difference a decade can make! I originally ordered
Office 2010 for Dummies because that's what we were going to use. However, we were sold on
Office 2013 by two different retail stores. So, here we were with Office 2013 and the Office 2010
manual. I didn't know squat about either, so I just jumped right in and started working. I found
that the manual was just as helpful for 2013 as it was for 2010. There are a few additions,
naturally, but it's basically the same. If you're like us and don't know much or anything at all about
Office 2010 or 2013, this is the book for you! It covers EVERYTHING in a clear and concise
manner that I believe you'll find most helpful.”

Odalys Fernandez, “It takes getting use do at first.. This book gives you a complete description
on how to go about doing XY & Z. I guess that's why it's called Office 2000 for Dummies, huh. If
you already know how to do XY or Z in general, like how to cut and paste, etc., I suggest you
skim the paragraph instead of not reading it at all. You will get a better understanding of where
the writer is going with this or that. I was so frustrated at first that I skipped around in the book
and then realized it's better to just skim the paragraph. Why you asked, because recruiters often
want to test you on Word, Excel or PowerPoint and these tests require that you use the default
method.  I love using the shortcut menus, but I still need to know how to use default method.”

Randy Tyler, “Good overview of Office 2010. The book's first chapter covers the general
commands commonly used in all Office 2010 apps and has several more chapters, one for each
of the apps in greater detail. Some of the processes like embedding a photo behind a table or
chart are not broken into enough steps to follow the process as one duplicates the actions in one



of the apps to learn how to do it. There are numerous things Office 2010 can do and this book
covers most if not all of them. It is a good book for beginners without much experience with word
process software but does require familiarilty with computer usage in general.I would buy it
again and would recommend it to others.”

Nan B., “Very useful so far!. Just what I wanted to use as a guide as I transitioned from Office 97
to Office 2010 plus I'm supposed to be able to load it on 2 computers. I've loaded it to my HP all
in one computer but I haven't tried to load it to my Dell laptop. I don't expect any problems but
we'll see. I will update this if I run into problems. I just wish that "my keywords" were the same
as the authors.”

WendyArleen Harrison, “Great Product. I'm not usually a fan of the "Dummies" series, so I
studied the chapters with a critical eye. I found the content has been written for both the novice,
the inbetweener and the advanced user of Microsoft Office 2010. The author is quite
opinionated and sometimes seems to favour using a free program from the internet instead. I
keep this book close at hand and refer to it often as I go about my daily work and I am learning
how to do things faster. I like to back this up with youtube videos and then use the book as a
refresher or reference. I think it's a good book.”

Mike Boardman, “Does its job. I still don't particularly like the (over) jokey style, although it's not
as bad as some of the other "Dummies" books.Having said that, it covers the basics pretty well. I
would have put some of the sections in a different order, but I understand that that is largely a
matter of preference.”

Nigel, “Good book. So far it seems easy to follow and understand, it’s a great reference book for
beginners and everyone else that needs a catch up”

Jan moody, “Brilliant. Great”

DG Irvine, “Office 2010. Thank you, this book makes it a lot easier”

Rose Kyei, “I loved it. It was New as advertised and served .... I loved it . It was New as
advertised and served the purpose.”

The book by Marvin A. Stokes has a rating of  5 out of 4.3. 270 people have provided feedback.
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